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1. Uvod

Ideja za Color Switch igricu prvenstveno je u vlasnisStvu “Fortafy Games” i koristi se u ovoj
literaturi samo u edukacione svrhe. Mi smo ovde kreirali Clone verziju kako bi pokazali kako

Za potrebe kreiranja dizajna (Front-enda) ove igrice koris¢ena je verzija Unity 5.5.2 i
preporucujemo da azurirate starije verzije na novije zbog nekih pogodnosti i mogucih

Za kodiranje (back-End) pisan je kod u C# u Visual Studio 2015 ali mozZe i neki drugi editor

Voditi ra€una o ¢estom ¢uvanju projekta i Scena kako bi se izbeglo nepredvideno gubljenje
podataka | postignutog ucinka. Za potrebe ¢uvanja scena preporucujemo da se kreira

Davati smislena imena folderima, skriptama, promenljivama i objektima kako biste mogli
Obratiti paznju za koju platformu pravite igricu i najbolje bi bilo da se na pocetku projekta

Svaka scena da bi mogla da se pokrene kao apk mora prvo biti “izbildovana” a to se radi

1.1. Napomene potrebne za izradu projekta
2.
ona moZe da se napravi u Unitiju.
3.
razlika sa starijim verzijama ukoliko ste imali Unitz pre iyrade ovog projekta.
4.
kao sto je npr. Mono Developer-u
5.
poseban folder u Assets/Scenes/... kao i da se daju smislena imena scenama.
6.
lakse da pratite strukturu foldera projekta i sam kod.
7.
izvrSe potrebna podesavanja.
8.
tako Sto se odabere File->Build Settings
9.

Vodite racuna da struktura projekta bude uredno rasporedena zbog vase licne preglednosti

i boljeg snalaZenja kako za Vas tako i za onog ko ¢ita Vas kod.

1.2. Odabir platforme i orijentacija ekrana

Da bi se odredena scena mogla
pokrenuti/ukljuditi u igricu i da bi mogla
da prikaze ono Sto ste joj dodali
neophodno je prvo “Izbildovati” je kao i
selektovati platformu za koju Zelimo da
kreiramo igricu, a Unity nam u tome jako
olaksava posao jer je vrlo jednostavno.
Ove opcije snalaze u File->Build Settings.
Ako imamo neku scenu za bildovanje
onda je dodajemo odabirom na Add Open
Scenes (ovo dugme dodaje aktivnu
scenu).

Da bismo promenili platformu moramo
prvo imati instaliran modul za platformu
koju Zelite da selektujete. Posto mi Zzelimo
da kreiramo krajnju igricu za android kada
selektujete opciju “Android” videéete da
¢e Vam traziti modul koji verovatno
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nemate. Kliknite na opciju Open Download Page i skinu¢e Vam se neophodna instalacija koju
nakon toga pokrenete.

=0 X
pport Setu == Yl @ Unity 5.5.2f1 Android Support Sstup p— (=R

- Choose Components
f'?;?glr;es::)pg:)?_t%n‘;ﬂSSZrl Choose which features of Unity 5.5.2f1 Android Support you want to install. @

Setup will guide you through the installation of Unity 5.5.2f1 Check the components you want to install and uncheck the components you don't want to
Android Support. install. Click Next to continue.

It is recommended that you dose all other applications
before starting Setup. This wil make it possible to update

relevant system files without having to reboot your Select components to install: Unity Android Support|
computer.

Click Next to continue.

Space required: 306.9MB

Mext = ] [ Cancel < Back ][ Next > ] [ Cancel

Instalacija ¢e Vam traziti da ugasite Unity editor kako bi mogao da implementira instalirani modul
po zavrSetku tako da to i uradite. Kada se vratite u projekat idaberite opciju Swtich Platform koja
¢e Vam sada biti omoguéena i ikonica za unity ¢e se prebaciti na Android.

NAPOMENA: NAJBOLJE JE DA PLATFORMU SELEKTUJETE PRE POCETKA IZRADE PROJEKTA ZBOG
RAZLICITIH REZOLUCIJA | DIMENZIJA KAMERE KAKO NE BISTE POSLE NA KRAJU MORALI SVE DA
NAMESTATE. ZATO ODMA NA POCETKU VAM BUDE SVE PODESENO | SPREMNO ZA RAD.

Kada pokrenete ponovo Vas projekat i u Build Settings odaberete android platformu videcete da
¢e sada prozor izgledati drugacije. Omogucéeno je i dugme Player Settings koje se koristi za neka
osnovna podeSavanja aplikacije. PoSto ovu igricu pravimo za Android mi ¢éemo odabrati Android
platformu. Ali igrica ¢e moci da se pokrene i na PC ra€unaru. Vi mozete lako da odaberete i iOS ili
koju god Vi Zelite platformu.

Cursor Hotspot ®|o Y0

Ako Zelite da promenite automatsko rotiranje ekrana tj
orijentaciju ekrana na androidu manuelno idete na Files | oo s ' *
>Build Settings->Player Settings u Inspector prozoru odabrati | Reselution and Presentation

Orientation

polje za Android | opciju Default Orijentation postavite na | octuroriertations  [pamar -

H Ha Use 32-bit Display Buffer! ¥ Portrait
Portralt kao na SIICI' Disable Depth and Stencil Portrait Upside Down
Show Loading Indicator Landscape Right
* Shared setting between mul Landscape Left
== Auto Rotation
Ostalo je jos samo da podesite rezoluciju Kamere tj kako ¢e splash Image
se Vasa igrica prikazivati. Odaberite opciju kao sa slike. Other Settings

Publishing Settings

# Scene | € Game | {5 Asset Store 2 Animator

WWGA Partrait (480x800) % Scale (& 0.61:




1.3. Kratak pregled finalnog proizvoda
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2. Kreiranje loptice

U ovom poglavlju zapocinjemo izradu nase igrice. Pokrenuti program u kome éemo kreirati nasu
igricu Unity 5.5.0. Nakon startovanja Unity programa prikazuje se prozor za kreiranje novog
projekta, koji ¢e biti 2D. U okviru polja Project name unosimo naziv projekta, u ovom slucaju
ColorSwitch ,a Location predstavlja mesto gde Ce se nas projekat Cuvati. Lokaciju mozemo lako
promeniti odabirom ,,...“.
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Ci\Users\Documents\UnityProjects

3De 2D Add Asset Package

Slika 1 Pocetni prozor

Nakon klika na dugme Create project otvara se okruzenje-Editor Unity programa. Assets folder je

u pocetku prazan.

X Unity 5.5.2f1 Pe C - PC, Ma

File Edit Assets GameObject Component Window Help

(O[S = [ =% Center | @ Local | [ @ collab - | [ & | [Account - | [Layers - |[Layout -

| € Game £ Asset Store %8 Animator == © Inspector | Services 2=
RIEIEAEI=ES

‘= Hierarchy | M= #Scene
Create ~| (@Al

7 Quntitled =)
Main Camera
1 Project | Bl console a
| Create ~ ) e
[ Assets
This folder is empty
—C

Slika 2 O kruzenje Unity programa

Prvi korak pri kreiranju igrice je snimanje glavne scene. Scene ¢emo Cuvati u okviru foldera
Scenes, koji ¢e biti podfolder foldera Assets (desni klik na folder

Assets ->Create ->Folder-> imenujemo ga Scenes).




& Unity 5.5.2f1 Personal
Fie Edit Assets

GameObject Component Window Help.

(O[S H | = Center | @ Local | (> 11 [ M [ @ collab - | [ ] [Account - | [Layers - | [Layout -]
ierarchy # Scene € Game £ Asset Stare %8 Animator «=| @ Inspector Services & .=
Shaded MIEENEIE =S Gizmos *| (AT
Main Camera
Create Folder
Show in Explorer o
e Javascript
Delete Shader
Open Scene Additive Testing
Import New Asset.. Scene
Import Package Prefzb
Epmifedera Audio Mixer
Find References In Scene
Select Dependencies Material
Lens Flare
Refresh Ctrl+R
e i Render Texture
Reimport Lightmap Parameters
2 Project El¢ R Sprites Ei o
Create ~ a | 4[| *

dereatesl | pyn APIUpdater..
» | 7 Favorites

Open C# Project

Animator Controller
Animation
Animater Qverride Controller

Avatar Mask

Physic Material
Physics Material 2D

GUI Skin
Custom Font

Legacy

folder is empty

Asset Labels

AssetBundle

Slika 3 Kreiranje foldera Scenes

Scenu shnimamo na slededi nacin:

File->Save Scenes->nakon ¢eqa biramo folder Scenes ->scenu ¢uvamo pod nazivom Level.

|| Create - Shaded
v € untitled

Main Camera

£ Asset Store %8 Animator
<b) | -

Gizmos ~| (ATl

(O] [S]H [= center | @Local | (> 1 [p] [ @collab - | [& | [Account - | [Layers -] [Layour - |
= Hierarchy # Scene o= O Inspector | Services .=

&) Save Scene
@Q b icons b ColorSwitch b Assets b « | 9 I Search Assets
Organize v New folder @
e Name Type Size
B Desktop Animation File folder
18 Downloads Audio File folder
= Recent Places Prefabs File folder
Scenes File folder
9 Libraries E Scripts File folder
= Documents Sprites File folder
& Music
&= Pictures
B videos
ﬁ: PA 2@ Homegroup
]
18 Computer
£ Local Disk ()~
File name: Level .
v Save as type: | unity -
v
~ Hide Folders
-

Slika 4 Snimanje scene Level

Sledeci korak jeste kreiranje. Uvozimo dva sprajta, u podfolder Assets/Sprites/. Prvi pod nazivom
sphere , koji predstavlja lopticu i ima slededi izgled:



Slika 5 Sphere sprite

Drugi pod nazivom rectangle koji ¢emo koristiti za kreiranje prepreka/objekata

Slika 6 Rectangle sprite

Nakon $to prebacimo sprite-ove u folder Sprites, selektujemo oba sprite-a, i u Inspector prozoru
sa desne strane za Texture Type postavimo Sprite(2D and Ul) , kao na sledecoj slici:

J Unity 55.2f1 Pe - -
File Edit Assets GameObject Component Window Help

V] ‘i‘ ol f@ [sicenter| Siocal [ [ 11 pi] @ Collab + | [ & | [Account Layer Layout
= v &= #Scene € Game £ Asset Store P8 Animator © Inspector | Services =
eate Shaded -|[20 || % | <€) | = I- Gizmos - | (AT 2 Textura a0s Import Settings F
eram =
Main Camera
Texture Type [spiite 2Dandu) 1]
Texture Shape Default
Sprite Mode Normal map
Packing Tag Editor 6Ul and Legacy GUI
pixels Per Unit V| Sprite @D and U
Mesh Type
Extrude Edges Cursor
Pivot Cookie
Lightmap |
N — Single Channel
Wrap Mode Clamp :
Filter Mode [Bilnear 3]
Aniso Level Cr ]
Defaute |2
@iproject | []Console &=
Create - = ||| % | |LJOverride for PC, Mac & Linux Standalone
M Siz 20
» 1/ Faverites Assets - Sprites il ie a8
Compression Hormal Quality
¥ Assets Format RGBA Compressed DXTS
@ Scenes
[-] [~] 2 Tewture 2Ds ———————————
= ¥

rectangle L score ] . [r—

Previewing 2 of 2 Objects

"R rmata Asta fila [ matal aviers kit e aseat esate /Cranas fmain inib' can' ha frind Whan mauina ae dzlatinn filas aikeids of init mlases aneoes thak tha fneeaen

Slika 7 Podesavanje za dva dodata sprite-a

Iz foldera Sprites oba sprite-a prevu¢emo na glavnu scenu (Level), u Hierarchy prozor. Klikom na
sprite sphere mozemo sada da mu promenimo ime i nazvacemo ga BallPlayer kao igraceva loptica.



U Hierarchy prozoru, dobijamo moguénost podesavanja tog sprite-a u okviru Inspector prozora
(isto vaZi i za sprite rectangle).

£ Asset Store 8 Animator == © Inspector Services -

) |

Gizmos *

E‘BaHP\avar ‘Dstatlc -
Tag [ Player +| Layer | Default &)
Prefab | Select I Revert I Apply |
¥ .~ Transform &
Position X 0.007 ¥ -3.7462¢ Z 0
Rotation X0 Yo z0
Scale *|0.06 ¥ |0.06 Z/1.011374
v (5 |¥ Sprite Renderer o
Sprite [Elscore ]
Color [ 12
Flip LI
Material | Sprites-Default ]
Sarting Layer | Defaulc
QOrder in Layer |0
v~ Rigidbody 2D W3
Body Type | Dynamic +
Material |Non= (Physics Material 2D) | @
Simulated [+
Use Auto Mass -
Mass 1
Lingar Drag 1]
Angular Drag 0.05
Gravity Scale 0.7
Collision Detection [ Discrate
Sleeping Mode | Start Awake
Interpolate | Mone
¥ Constraints
b Info

Slika 8 Sprite-ovi prebaceni na main scenu

Kada kreiramo objekat, Unity mu automatski dodeljuje komponentu Transform pomocu koje
mozemo da podesavamo:

e Position — menjamo poziciju objekta
e Rotation - rotiramo nas$ objekat
e Scale — menjamo dimenzije objekta

Position X0 |v[3.83 |z[o
Rotation X|0 Y0 Z\0
Scale H 0.06 Y 0.06 Z0.0987
¥ |2 ¥ Sprite Renderer 3
Sprite [I-Isphere | e
Color [ 12
Flip - .
Material |@ Sprites-Default | &
Sarting Layer | Default
e Al i
of the Renderer's sorting Iaverli
¥ HRigidbody 2D Qs
Body Type | Dynamic E
s - Ty et g e T A -

Slika 9 Transform komponenta za sphere
Pozicije i dimenzije postavljamo proizvoljno.

Kada je re€ o sprite-u kao u nasem slucaju, pored Transform komponente Unity dodaje Sprite
Renderer komponentu, koja je pokazivac na sprite i u kome se pored ostalih moguénosti nalazi i
polje Color kao i ime sprajta:



v [« Sprite Renderer o,
Sprite " sphere -
Color | | #
Flip O=xOy
Material W Sprites-Default Lo
Sorting Layer | Default ™
Order in Layer 0 |

Slika 10 Sprite Render komponenta za sphere

Sledece $to je potrebno sprite-ovima dodati je fizika.

1. Selektujemo BallPlayer u Hierarchy prozoru -> Component -> Phisics 2D -> Rigidbody 2D ili
2. Klikom na BallPlayer u Inspector prozoru odaberemo opciju Add Component i nademo
RigidBody2D $to ¢emo mi uraditi.

Add Component

(2. Figi @)
Search
% Rigidbody
New Script 3

Slika 11 Dodavanje Rigidbody komponente

Nakon ¢ega nam se u Inspector prozoru za selektovani sprite dodaje Rigidbody2D komponenta:

¥~  Rigidbody 2D %,
Body Type | Dynamic —
Material |Nor‘|e (Physics Material ZD) | o]
Simulated [+
Use Auto Mass -
Mass 1 |
Linear Drag [ |
Angular Drag [0.05 |
Gravity Scale 1 |
Collision Detection | Discrete o
Sleeping Mode | start Awake &l
Interpolate [ rMane &

W Constraints

» Info

Slika 12 Rigidbody 2D za sphere



Ova komponenta stavlja sprite-ove pod kontrolu engine-a za fiziku. To omogucava da sprite bude
pod uticajem gravitacije(Gravity Scale je 1 — koliko jako ¢e gravitacija uticati na objekat). Ukoliko
sada pokrenemo projekat, klikom na dugme play, primetiéemo da nasa loptica pada, jer na nju
sada deluje sila gravitacije. Medutim mi Zelimo da nasa loptica ostane u mestu i da ne pada. Zato
¢emo za sada kreirati podlogu koja ée joj omoguditi da ne propadne ve¢ da stoji u mestu kada
dodirne sprite PointerOnBall .

Iz tog razloga selektujemo sprite iz foldera Assets/Sprites/pointeronball, i dodajemo u Hijararhiju
kao objekat, a zatim mu dodajemo komponentu BoxCollider2D (Add Component -> Box Collider
2D). Postavi¢éemo ga ispod loptice. Takode dodajemo i BoxCollider2D na sprajt rectangle kao sa
slike 13.

v M ¥ Box Collider 2D #,
Edit Collider
Material |Nune (Physics Material 2D]|| @
Is Trigger ]
Used By Effectar [
Offset
X0 [Y[o |
Size
X|2.77 Y 0.7499999 |
b Info
Sprites-Default #,
[ Shader | Sprites/Default =

Slika 13 Box Collider 2D za rectangle sprite

Dakle, BoxCollider2D dodajemo kao komponentu za sprite-ove kojima Zelimo da omoguc¢imo
Ltezinu“ odnosno fiziku sudaranja sa drugim objektima (kolizijom). Nakon dodavanja
BoxCollider2D-a, sprite rectangle, postaje oivicen zelenom linijom, Sto se moze primetiti u Scene
prozoru:

£ Asset Store Animator = | ® Inspector Services - =

| PointeronBall [] Static =
Tag | Untagged +| Layer | Default :]
Prefab | Select | Revert ] Apply |
¥ .~ Transform *
Position X 0.11 Y -5.2 20
Rotation X0 Yo Z0
Scale X0l T 0.1 21
v |5l ¥ sprite Renderer #*
Sprite |:°:E|-po|nter.qu | (]
Color [ |
Flip OxOy
Material |USprites-Defau|t | @
Sorting Layer | Default
Order in Layer |0
v M ¥ Box collider 2D G #
Edit Collider
Material |None (Physics Material 2D} | Q
1s Trigger -
Used By Effector -
Offset o vy |
Size x[z0  |v[z0
b Info

Sprites-Default @ %
» Shader | Sprites/Default -

[ Add Component l

Slika 14 Izgled sprite-a nakon dodavanja Box Collider —a 2D
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Za sprite BallPlayer dodajemo (u skladu sa oblikom) CircleCollider2D (Add Component -> Circle
Collider 2D).

v @ ¥ Circle Collider 2D 0 %
Edit Collider
Material Mane (Physics Material 2 @
Is Trigger -
Used By Effector -
Offset
x|0 ¥ 0
Radius 2.5
b Info
Sprites-Default @ .
Shader | Sprites/Default .

Slika 15 Circle Collider 2D za sphere

Kada pokrenemo projekat vide¢emo da dolazi do kolizije ova dva objekta:

WWGA Portrait (480x800) +| Scale = 1,61 Mazximize On Play | Mute Audio | Stats | Gizmos =

Slika 16 Loptica se zaustavlja pri dodiru sa objektom PointerOnBall
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2.1. Kretanje loptice —igraca

Slede¢a funkcionalnost koja je jako
vazna kod igrice Color Switch jeste da
omoguc¢imo da se loptica svaki put
kada kliknemo na taster misa/touch
kreé¢e nagore. Da bismo ovo omogucili
kreiramo C# skriptu, u okviru foldera
Assets/Scripts/ na sledeci nacin: Desni
klik na koren foldera

Scripts -> Create -> C# Script -> Ball.cs.

Skriptu Ball.cs pokreéemo preko
Visual Studija. Osnovne metode koje
kreira Unity su Start(), koja se poziva
prilikom pokretanja skripte i Update()
metode. Umesto Update() metode,
koristimo FixedUpdate() koja se
uglavnhom primenjuje kod vremenski
osetljivih kodova ili za fiziku kao sto je
ovde slucaj.

B Project El

€ Urity 5.5 21 Personal (5458 - maimurity - ColoSitch - P, Mac & Linux Standalone* <0X115 TN

= Hierarchy

| create -| (@-AT )]

File Edit Assets GameObject Component Window Help

IR IEENEA =

Display 1 4| | Free Aspect

¥ € main* =
Main Camera
sphere
[EEt=nTE Create 3 Folder
Show in Explorer C# Script
e Javascript
DR Shader 3
Open Scene Additive Testing 3
Import New Asset... Scene
Irmport Package 3 Prefab
Eporlasade Audio Mixer
Find References In Scene
Select Dependencies Rdateual
Lens Flare
Refresh Ctrl+R Render Texture
1 Project I Reimport Lightmap Parameters
Create ~ Reimport All -
e
» 7 i Favorites BRI
e Fater Animator Controller
v ﬁ Assets
&5 Scenes Open C# Project Animation
Animator Override Controller
Sprit
e HAyatar Mask
Physic Material
Physics Material 20
GUI Skin
Custom Font
Legacy 3

Slika 17 Kreiranje C# skripte

| Create "|

T"{:FFawurites
@lﬁll Materials
(2 Al Madels
@lﬁll Prefabs
@lﬁll Scripts

‘!’As!eti

&5 Audio
&3 Prefabs

ﬁScenes

&5 Sprites

Slika 18 Ball.cs

Assets » Scripts

-
€




Skripta Ball.cs ima slededi sadrzaj:

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class Ball : MonoBehaviour

{

public float intensity; //jacina sa kojom loptica odskace

private Rigidbody2D rb2d; //referenca na kompnentu Rigidbody2D

public float MaxVelocity ; // dokle najvise da promeni poziciju po y osi -skok
public float MaxDownward; // dokle da padne

// Use this for initialization
void Start()

{
rb2d = GetComponent<Rigidbody2D>();
}
void FixedUpdate()
{

if (Input.GetMouseButtonDown(®)) //ako kliknemo levim tasterom misa

{

//add force upward, or add impulse upward
if (rb2d != null)
{

}

rb2d.AddForce(Vector2.up * intensity);

if (rb2d.velocity.y > MaxVelocity) // da onemoguci lopti da skace previsoko

rb2d.AddForce(Vector2.down * 30);
}

if (rb2d.velocity.y < MaxDownward) // max velocity kada pada y ispod @ dokle moze
da pada

{
¥

rb2d.AddForce(Vector2.up * intensity);

Sada je potrebno ovu skriptu dodeliti objektu BallPlayer, a to radimo tako sto skriptu prevuéemo
na objekat ili odabirom objekta pa Add component i nademo skriptu po imenu.. U inspector
prozoru dodeliti veli¢ine trima promenljivama po vasem nahodenju ali na slici 19 je dat prikaz kako
smo mi nasli ,zlatnu” sredinu.

¥ || [« Ball (Script) %,
Script Ball (o
Intensity 250 |
Max Velocity |5 |
Max Downward L4 |

Slika 19 Podesavanje promenljivih za kretanje loptice
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&) Unity 5.5.2f1 Personal (64bit) - main.unity - ColorSwitch - PC, Mac & Linux Standalone™ < D11 >

File Edit Assets GameObject Component Window Help

EIEIEIEA [ | e > (5 conse - [
= Hierarchy & -= i Scene € Game £ Asset Store 8 Animator =
| Ereate - | (@rAT ] Display 1 #|| Free Aspect + - Maximize ©n Play | Mute Audio | Stats | Gizmos |~

v € main*
Main Camera

B3 Project El console F
| create -| N\ @& [ *
» i 7Favorites Ass\s ~ Scripts
¥ 55 Assets \ —

& Scenes .
C#

Gl Sprites L

|Gr| PlayerScript.cs —

Slika 20 Prevlacenje skripte na objekat

Sada se loptica na klik misa krece na gore, medutim nju ne prati kamera. Da bismo to obezbedili
Main Cameru prevucemo na objekat BallPlayer, ¢ime taj objekat postaje roditelj objekata Main
Camera. Na slici 21 je prikazano kako se Main Camera dodeljuje objektu BallPlayer Cime postaje
loptica roditelj kameri i time smo resili problem pracenja loptice kamerom.

@ Inspector Services & .= I
& |[Main Camera | Static * TBE”PIE?EF
Tag | MainCamera 4| Layer | Default 4 Ma|n Camera
Prefab | Select ] Revert ] Apply |
¥ .~ Transform %, : : :
Position X 04547396 ¥ 41.16668 Z|-9.8B87535 Sllka 21 Maln camera kao dete Ioptlce
Rotation H 0 Y0 Z0
Scale X 98.04742 ¥ 92.54514 Z 0.9887535
v& ¥ camera %,
Clear Flags | Skybax ]
Cerren R
Culling Mask Everything =
Projection | ©rthagraphic m
Size |5
Clipping Planes Near |0.3
_ FTr 1000 - | Podesiti da kamera Main Camera bude
Viewport Rect ®|0 0
W T | veli¢ine otrpilike 5. To se radi tako Sto se
Depth -1 | . . .
Rendering Path | Use Graphics Settings m promenl vreanSt pOIJa Slze u prozoru
Target Texture |None (Render Texture) | o] |nSpect0r
Occlusion Culling [ )
HDR O
L' ¥ GUI Layer o,
w ¥ Flare Layer *
() ¥ Audio Listener %,
v & ¥ Audio Source o,

Slika 22 Main Camera
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2.2. Menjanje boje loptice

Zbog boljeg vizuelnog efekta, boju pozadine, koja je plava, menjamo u crnu, na slededi
nacin: klikom na Main Camera u Hiararchy panelu, dobijamo moguénost podeSavanja pozadine u
okviru Inspector panela. Tu okviru komponente Camera, imamo Background sekciju gde biramo
boju pozadine, postavite da bude crna.

Trenutna boja loptice je bela. Nas cilj je da omoguc¢imo da loptica menja boje nasumicno ali posto
ne zna koje boje sme da koristi mi moramo to da joj kaZemo na osnovu predefinisanog intervala
boja odnosno niza. Iz tog razloga kreiramo prazan objekat koji ¢emo nazvati Menager (Game
Object -> Create Empty -> objekat imenujemo Menager). Ovo je objekat koji ¢e kontrolisati celu
scenu i biée referenca na poene, na lopticu itd. Sada kreiramo skriptu MenagerReferences.cs u
folderu Assets/Scripts/ koju dodeljujemo objektu Menager. Skripta izgleda ovako:

using System.Collections;

using System.Collections.Generic;
using UnityEngine;

public class MenagerReferences : MonoBehaviour

{
public GameObject ball; //referenca na objekat sphere

public Color[] Colors; //referenca na niz boja
// Use this for initialization
void Start()

{
¥

// Update is called once per frame
void Update()
{

¥
}

Nakon sto u skripti navedemo referencu na neki objekat iz Unity programa, npr. referenca na
objekat BallPlayer, u okviru Inspector prozora te skripte pojavljuje se polje sa nazivom reference,
gde je potrebno prevudi objekat, na koji se ta referenca odnosi.

© Inspector | Services - -
o Manager ] Static -
Tag | Untagged 4| Layer | Default :
¥ .~ Transform ﬁ
Position ®|3.1636 Y |-2.282143 Z 0
Raotation X0 Y0 Z0
Scale X1 Tl Z[1
"@ ¥ Manager References (Script) @
Script ManagerReferences
Player Sphere [\isphere ]

[ Add Co nent ]

Slika 23 Dodavanje reference skripti
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Nakon dodavanja reference na niz boja, u Unity programu, u okviru komponte koja definiSe
ManagerReferences skriptu, dobijamo moguénost definisanja prvo veli¢ine niza, a zatim i boja koje
Zelimo da se nadju u nizu Colors:

[ & Collab ~ ] [ e} ] [Accnunt - ] [La\rers - ] [Laynut - ]
@ Inspector Services a .o
& Menager || static =
/ Tag [ Untagged #] Layer [ Default #]
& ¥ .~ Transform ]
Position ¥ -0,1550809 | ¥ -0.003417884) Z |0
Rotation bl Rl |z]o
Scale x[1 |2 |z]1
E ‘l' [« Menager References (Script) e
= I Script MenagerReferences o]
= " Ball |uBaIIPIaver | o]
- ¥ Colors
Size |5
Element 0 - F
Saturation Element 1 | Lﬁ
=) Element 2 ¢
— 755 Element 3 I,
_:| o Element 4 I

Hex Colar

I Presets

# FFOO0OFF

Add Component ]

Slika 24 Dodavanje boja

Strelica na prethodnoj slici ukazuje da alfa uvek mora da ima vrednost 255 da bi loptica mogla da
primi boju inace ¢e imati boju crnu kao osnova i neée se primecivati na kameri. Sada je potrebno
dodeliti boje objektima. Loptica treba da ima random boje, svaki put kada se igrica startuje. Da
bismo to obezbedili modifikujemo skriptu Ball.cs na sledeci nacin:

using System.Collections;
using System.Collections.Generic;
using UnityEngine;

public class Ball :

{

MonoBehaviour

public float intensity; //jacina sa kojom loptica odskace
private Rigidbody2D rb2d; //referenca na kompnentu Rigidbody2D
public float MaxVelocity ; // dokle najvisSe da promeni poziciju po y osi -skok

public float MaxDownward;

// dokle da padne

// Use this for initialization
void Start()

{

}

rb2d = GetComponent<Rigidbody2D>();
InitializeColor();

void FixedUpdate()

{

if (Input.GetMouseButtonDown(®)) //ako kliknemo levim tasterom misa

{
//add force upward, or add impulse upward
if (body != null)
{
Rb2d.AddForce(Vector2.up * intensity);
}
}
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if (rb2d.velocity.y > MaxVelocity) // da onemoguci lopti da skace previsoko

{
rb2d.AddForce(Vector2.down * 30);
}
if (rb2d.velocity.y < MaxDownward) // max velocity kada pada y ispod @ dokle moze
da pada
{
rb2d.AddForce(Vector2.up * intensity);
}
}
void InitializeColor()
{
//pravimo referencu na objekat Manager
MenagerReferences refs =
GameObject.Find("Menager").GetComponent<MenagerReferences>();
if (refsl!l=null)
{
//broj boja
int colorCount = refs.Colors.Length;
//random boje u opsegu od © do maksimalnog broja boja
int randomIndex = Random.Range(@,colorCount-1);
//kreiranje nove random boje
Color newColor = refs.Colors[randomIndex];
//posto je loptica(sphere) Sprite, uzimamo tu komponentu i dodeljujemo joj
boju
SpriteRenderer render = GetComponent<SpriteRenderer>();
render.color = newColor; //nova boja
}
}
}

2.3. Kreiranje Prefab elemenata

Kopiranje obejekata ée sigurno proizvesti duplikate, ali
osobine duplikata se moraju posebno menjati. Da bi se
izbeglo ovako neSto, Unity podrzava Prefeb assets tip
sredstva koje omogucava da sacuvamo GameObject
objekte zajedno sa komponentama i svojstvima.

B Project E console

Na kraju treba da kreiramo Prefab folder U |creae-|
Assets/Prefabs/ kako bi tu smetali kreirane objekte da jh T Faverites

@AII Materials

. . .. . . v v . .o ch
ne bi duplirali i pojedinacno svakom podesavali opcije u tgk;::: Hodels

Inspector prozoru prevlaéenjem iz hijararhije projekta u CLall seripts

folder prefabs dobijamo objekat saduvan za ubuduce 'ﬁ%szez_s -
udio allPlayer

koris¢enje na onoliko mesta koliko mi Zelimo sa
. . . .o . 7 7. . scenes
predefinisanim opcijama. Sada Lopticu éemo prevudi u taj & Scripts
. . e . . .. &5 sprites
folder kako bi mogli kasnije istu lopticu za naredni nivo da

samo prebacimo iz ovog foldera kao na slici 25. Slika 25 Kreiranje Prefabs-a

Assets » Prefabs

Ono Sto je Vazno za Prefabs elemente jeste da ukoliko se nakon kreiranja prefab-a promeni neka
vrednost objektu mora se odabrati u gornjem uglu opcija ,,Apply”“ kako bi se nove vrednosti
dodelile svim istim objektima na sceni ukoliko Zelimo ako ne onda ostavljamo samo za taj element
novu vrednost bez odabira apply opcije za sve.
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3. Dodavanje drugog objekta

Dodacemo obican Rectangle sprajt (ako ga niste dodali u prethodnom poglavlju) iz foldera Assets/Sprites/
na scenu kako bi videli kako se loptica sudara sa drugim objektom i Sta treba da objekat radi kao |
podesavanja za objekte od kojih ¢e se kasnije praviti razne druge prepreke.

3.1. Kreiranje objekta za koliziju

Nakon $to smo dodali rectangle treba da podesimo Sirinu i visinu pravougaonika kao na slici. Posle
kada ovaj objekat dodelimo jednom objektu i kreiramo vise onda moZemo da ga obrisemo iz
hijararhije.

Tag | Untagged t| Layer | Default |
¥ .~ Transform Q) =
Position X|1.68 ¥|-1.28 Z0
Rotation X0 Y0 Z0
Scale X|0.7 0.4 21
¥ [l ¥ Sprite Renderer @ #
Sprite Lrectangle @
Color [ | 2
Flip Ox [y
Material W Sprites-Default @
Sorting Layer | Default 4]
Order in Layer 0
v H ¥ Box Collider 2D @ %=
Edit Collider
Material MNone (Physics Material 2D) @
Is Trigger -
Used By Effector -
Offset x|0 0
Size x|2.77 ¥ 0,75
» Info
Sprites-Default @ #

Slika 26 Podesavanja rectangle objekta

Zatim kreiramo prazan objekat HorizontalBar (GameObject - |¥ Steveli*

¥ sphere
>CreateEmpty). Ovom objektu kao podobjekat dodajemo prethodno "amera
kreirani sprite rectangle, i imenujemo ga u RedRectangle. Bojimo ga u ;"ei::;:’r”ba”

crveno, a u okviru komponente Transform za taj objekat postavimo |-—teuzentslear ___)
Position X:0 i Y:0. Zatim objekat HorizontalBar pozicioniramo iznad
loptice kao na slici ispod:

Unty 521 esnel 6451 - ety - CooSwih - P, Mo & e Sl <01 o
File Edit Assets GameObject Component Window Help
mE EI unm [  Collab ~ ] @ [Account z ] [Layers v] [Laycut
= Hierarchy | i .= #Scene | € Game i Asset Store %8 Animater o=| O Inspector | Services i
Create 7| (CrAll Display 1 # | Free Aspect #| Seale (e 1y Maximize On Play | Mute Audio | Stats | Gizmos ~ ¥ [ForizontalBar [ stat
Y Qmain® v [Untagged Al [Defaut
ol Tag | Untagge 4| Layer | Default
Main Camera ¥ .~ Transform |
rectangle Pasition %0 v[EE_ |z[o
Manager Rotation X0 Y[o Z[o
HorizontalBar Scale ¥ Y1 zT
RedRectangle
Add Component I
B Proiect | FlCansale a.=

Slika 27 Dodavanje prve prepreke
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Objektu RedRectangle sada dodajemo komponentu BoxCollider2D, kako bi detektovali sudar sa
lopticom. Kako bi loptica prolazila kroz objekat RedRectangle u komponenti BoxCollider2D

potrebno je Cekirati ociju Is Trigger da bi bila true .

v M ¥ Box Collider 2D

Edit Collider

Material Mone (Physics Material 2D)
Is Trigger [
Used By Effectar .
Offset .0 Y0
Size X|2.77 Y075
b Info

Slika 28 Dodavanje BoxCollider 2D komponente objektu RedRectangle

Za objekat BallPlayer potrebno je postaviti tag na Player, Unity sam nudi u predefinisanim
tagovima i tag Player ,ali i mi sami moZzemo da kreiramo tagove ako nam trebaju:

“r Collab = ] [ Pai] ] [Account - ] [La\rers - ] [La\rout -
© Inspector Services =
= & [sphere [] Static =

Tag [ Player t | Layer | Default s
w A T Untagged g #*
Position Respawn 1.44 Z|0
Rotation Einish 0 Z |0
Scale T 0.16 Z|1
— itorCn
v 5 o 55 o =
Sprite MainCamera @
Color ¥ | Player | #
Flip GameController
Material It =]
: Add Tag...
Sorting |
Order in Layer s}

Slika 29 Za sphere tag Player

Sledeéi korak jeste kreiranje skripte za koliziju sa drugim objektima
OnTriggerEnter2D(), koju dodajemo  objektu
Assets/Scripts/TriggerCollision.cs .

using System.Collections;

using System.Collections.Generic;

using UnityEngine;

public class TriggerCollision : MonoBehaviour

{

//za prepreke takodje koristimo boje definisena

void Start()
{

RedRectangle,

u MenagerReferences
public ColorUsed colorIndex; //u Unity-ju imamo mogucnost selektovanja zeljene boje

//referenciramo se na skriptu ManagerReferences

ManagerReferences refs =

GameObject.Find("Menager").GetComponent<ManagerReferences>();

if (refs != null)
{

Color newColor = refs.Colors[(int)colorIndex];
gameObject.GetComponent<SpriteRenderer>().color = newColor;//dodeljujemo

selektovanu boju objektu RedRectangle

}
}
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//funkcija koja detektuje koliziju izmedju prepreke na koju je postavljen triger,
//i Collider2D objekta, u ovom slucaju loptice(koja ima Circle Collider2D komponentu)
void OnTriggerEnter2D(Collider2D other)

//ako je objekat koji dolazi u koliziju loptica(koja ima tag Player)
if (other.gameObject.tag == "Player")
{

//implementiramo logiku igre

Color playerColor = other.gameObject.GetComponent<SpriteRenderer>().color;
//boja loptice

Color thisColor = this.gameObject.GetComponent<SpriteRenderer>().color; //boja
prepreke

if (playerColor != thisColor)

Debug.Log("GAME OVER!"); //ispis u konzoli a kasnije cemo dodati Sta ce da
radi kada se sudari sa drugom bojom

}
}

Verovatno ¢e Vam bojiti u skriptu red gde je tip ColorUsed. To je zato $to nismo jo$ definisali opseg
boja koje smemo da koristimo odakle ¢e on uzimati trenutnu boju objekta. Zato modifikujemo
skriptu MenagerReferences.cs sa sledeé¢im kodom koji dodajemo pre klase jer je u pitanju enum.
Enum predstavlja skup imenovanih integer promenljiva. Krecu od 0 i raste za +1. Voditi rauna jer
enum elementi dobijaju integer vrednosti iako su imenovani po Zelji i to istim redom kako su
definisani, dakle prvi element ima vrednost indeksa 0O naredni 1... Nama su ovde boje pa ¢éemo
definisati istim redom koji smo dodelili i Menager objektu.

public enum ColorUsed

{
Red,
Yellow,
Green,
Blue,
Purple
}
public class MenagerReferences : MonoBehaviour
{
}

3.2. Kretanje prepreke

Kako prepreka ne bi bila stati¢na, potrebno je omoguditi njeno pomeranje levo i desno. Za
to piSemo novu skriptu, koju dodeljujemo objektu HorizontalBar , roditelju objekta RedRectangle,
pod nazivom HorizontalMovement.cs .Ovom skriptom ¢emo definisati koliko levo, odnosno desno
¢e prepreka modi da se pomera.
using System.Collections;

using System.Collections.Generic;
using UnityEngine;

20



public class HorizontalMovement : MonoBehaviour

{

public float rangeMax = 10;

public float direction = 1; //ako je 1 pomera se desno, -1 levo

public float speed = 1; //brzina varira od objekta do objekta I posle se dodaje sve
brze I teze za viSe nivoe

public float initialPositionX; //pocCetna pozicija objekta poSto se pomera samo po X
osi

// Use this for initialization
void Start()

{
}

initialPositionX = this.transform.position.x;

// Update is called once per frame
void Update()
{
//pomeranje prepreke
this.transform.position = new Vector2(this.transform.position.x + (direction *
Time.deltaTime * speed),this.transform.position.y);

if (this.transform.position.x > initialPositionX + rangeMax)

{
direction = -1;
}
if (this.transform.position.x < initialPositionX - rangeMax)
{
direction = 1;
}
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